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commercial computer software 
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software documentation that is 
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government rights in excess of 
these rights customarily provided 
to the public to use, modify, 
reproduce, release, perform, 
display, or disclose commercial 
computer software or 
commercial computer software 
documentation. No additional 
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beyond those set forth in the 
EULA shall apply, except to the 
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from all providers of commercial 
computer software pursuant to 
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update, revise or otherwise 
modify the Software. With 
respect to any technical data as 
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Safety Notices

A CAUTION notice denotes a hazard. It 
calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. Do 
not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.
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Keysight Noise Figure Measurement Capability Upgrade Kit
Upgrade Kit Number: N5247-60116
Installation Note

Description of the Upgrade 

This upgrade adds noise figure measurement capability to your N5247A/B 
Option 423 or N5247B Option 425 4-port analyzer by adding Option 029 or 
E29 which includes:

— a noise down converter and noise receiver

— a bypass switch in ports 1 and 2

Refer to “Overview of the Installation Procedure” on page 13.

Getting Assistance from Keysight
By internet or phone, get assistance with all your test and measurement needs.

Contacting Keysight

Assistance with test and measurements needs and information on finding a 
local Keysight office are available on the Web at: 
http://www.keysight.com/find/assist

If you do not have access to the Internet, please contact your Keysight field 
engineer.

IMPORTANT! Option 029 or E29 requires Noise Figure Measurements 
Option S93029A/B. Option S93029A/B is not included with this kit. If you 
need to order Option S93029B, contact Keysight. Refer to “Contacting 
Keysight” on page 5.

This repair must be done at a service center or a self-maintainer service 
center! Refer to “Getting Assistance from Keysight” on page 5.

In any correspondence or telephone conversation, refer to the Keysight 
product by its model number and full serial number. With this information, 
the Keysight representative can determine whether your product is still 
within its warranty period.

http://www.keysight.com/find/assist
http://www.keysight.com/find/assist
http://www.keysight.com/find/assist
http://www.keysight.com/find/assist
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If You Have Problems With the Upgrade Kit Contents

Keysight stands behind the quality of the upgrade kit contents. If you have 
problems with any item in the kit, refer to www.keysight.com and the Contact 

Keysight ( ) link.

Getting Prepared

To successfully install this upgrade kit, you will need the following:

— A license key - refer to “License Key Redemption” below.

— A PDF copy or a paper copy of the PNA Service Guide - refer to 
“Downloading the Online PNA Service Guide” below.

— An ESD-safe work area - refer to “Protecting Your Workspace from 
Electrostatic Discharge” below.

— Correct tools - refer to “Tools Required for the Installation” on page 9.

— Enough time - refer to “About Installing the Upgrade” on page 10.

— Test equipment for the post-upgrade adjustments. To view the equipment 
list, click the Chapter 3 bookmark “Tests and Adjustments” in the PDF 
Service Guide1.

The PNA contains extremely sensitive components that can be ruined if 
mishandled. Follow instructions carefully when making cable connections, 
especially wire harness connections.

The person performing the work accepts responsibility for the full cost of 
the repair or replacement of damaged components.

1. See “Downloading the Online PNA Service Guide” on page 8.

www.keysight.com
www.keysight.com
www.keysight.com
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License Key Redemption

To enable the option product(s), you must request license key(s) file from the 
Keysight Software Manager: 
http://www.keysight.com/find/softwaremanager:

To complete the request, you will need to gather the following information:

— From the certificate

— Order number

— Certificate number

— From your instrument

(Instrument information is available in the network analyzer - on the 
toolbar, click Help, then click About Network Analyzer.)

— Model number

— Serial number

A models ONLY: From the online Keysight HostID utility:

— Part of the OEC procedure to obtain the 12-digit license key online requires 
you to provide the HostID number of the PNA. This HostID number is NOT 
the one currently shown on the PNA. To determine your new HostID, 
Keysight personnel should use the new model number with the utility at 
http://mktwww.srs.is.keysight.com/field/service/network/pna/upgrades.
html. Non-Keysight personnel should contact Keysight at 
http://www.keysight.com/key/contactus.

The only difference between an A model license key redemption and a B 
model is that the A model uses a 12-character license key and the B model 
uses a license key file.

Ensure that you are connected to an external server, before attempting to 
download your email and license key file. 

If you are unfamiliar with the licensing process:

– For A models: Refer to 
https://www.keysight.com/us/en/assets/9018-03565/installation-guides
/9018-03565.pdf (N5225-90110).

– For B models: Refer to the 
https://www.keysight.com/us/en/assets/9018-04534/installation-guides
/9018-04534.pdf (N5242-90024).

The enclosed Software Entitlement Certificate is a receipt, verifying that 
you have purchased a licensed option for the PNA of your choice. You must 
now use a Keysight Web page to request a license key file for the 
instrument that will receive the option.

https://:www.software.keysight.com/find/softwaremanager
https://:www.software.keysight.com/find/softwaremanager
http://www.keysight.com/find/softwaremanager
https://www.keysight.com/us/en/assets/9018-03565/installation-guides/9018-03565.pdf 
https://www.keysight.com/us/en/assets/9018-03565/installation-guides/9018-03565.pdf 
http://literature.cdn.keysight.com/litweb/pdf/N5242-90024.pdf
http://literature.cdn.keysight.com/litweb/pdf/N5242-90024.pdf
http://mktwww.srs.is.keysight.com/field/service/network/pna/
http://mktwww.srs.is.keysight.com/field/service/network/pna/
http://mktwww.srs.is.keysight.com/field/service/network/pna/
http://mktwww.srs.is.keysight.com/field/service/network/pna/upgrades.html
http://www.keysight.com/key/contactus
http://www.keysight.com/key/contactus
https://www.keysight.com/us/en/assets/9018-04534/installation-guides/9018-04534.pdf
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— Host ID

Using the information just gathered, you must request license key file(s) from 
the Keysight Software Manager: 
http://www.keysight.com/find/softwaremanager.

You will need to provide an email address, to which Keysight will promptly 
email your license key file. Refer to “License Key Redemption” on page 7.

Verify the License Contents 

Refer to the license message you received from Keysight: 

If the model number, serial number, or option number do not match those on 
the license message you received from Keysight, you will not be able to install 
the license key file. If this is the case you received from Keysight, you will not 
be able to install the license key file. If this is the case, contact Keysight for 
assistance. Refer to “Getting Assistance from Keysight” on page 5.

Downloading the Online PNA Service Guide 

To view the online Service Guide for your PNA model number, use the following 
steps:

1. Go to www.keysight.com.

2. In the Search box, enter the model number of the analyzer (e.g., N5225B) 
and click Search.

3. Click Support > Keysight Product Support.

4. In the Search Support area type your instrument’s model number (e.g., 
N2225B).

5. Press Enter. 

6. Scroll down to the PRINT DOCUMENTATION section and click to select 
Service Manual.

The Service Manual for your instrument will be displayed near the top of 
the right column.

7. Click the hyperlink of the Service Guide title to download the PDF file.

8. When the PDF of the Service Guide is displayed, scroll through the 
Contents section bookmarks to locate the information needed. 

https://:www.software.keysight.com/find/softwaremanager
https://:www.software.keysight.com/find/softwaremanager
http://www.keysight.com/find/softwaremanager
http://www.keysight.com/find/softwaremanager
http://www.keysight.com
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Protecting Your Workspace from Electrostatic Discharge

For information, click on the Chapter 1 bookmark, “Electrostatic Discharge 
Protection” in the PDF Service Guide1.

ESD Equipment Required for the Installation

Tools Required for the Installation

1. See “Downloading the Online PNA Service Guide” on page 8.

Description Keysight Part Number

ESD grounding wrist strap 9300-1367

5-ft grounding cord for wrist strap 9300-0980

2 x 4 ft conductive table mat and 15-ft grounding wire 9300-0797

ESD heel strap (for use with conductive floors) 9300-1308

Description Qty Part Number

T-6 TORX driver – set to 4 in-lbs (0.45 N.m) 1 N/A

T-8 TORX driver – set to 6 in-lbs (0.68 N.m) 1 N/A

T-10 TORX driver - set to 9 in-lbs (1.02 N.m) 1 N/A

T-20 TORX driver - set to 21 in-lbs (2.38 N.m) 1 N/A

5/16-in (8 mm) nutsetter or open end torque wrench- set to 10 in-lbs 
(1.13 N.m)

1 N/A

5/8-in (16 mm) nutsetter or open end torque wrench - set to 21 in-lbs 
(2.38 N.m)

1 N/A

9 mm nutsetter or open end torque wrench - set to 21 in-lbs (2.38 N.m) 1 N/A

Use a 5/16-in torque wrench set to 10 in-lbs on all cable connections 
except the front and rear panel bulkhead connectors. Torque these 
connections to 21 in-lb.
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About Installing the Upgrade

Products affected N5247A/B Option 423 and N5247B Option 425

Installation to be performed by Keysight service center or personnel qualified by Keysight

Estimated installation time 5.0 hours 

Estimated adjustment time 1.5 hours (with LFE 2.5 hours)a

a. Low Frequency Extension (LFE) source adjustment requires an additional 1.0 hour of test time.

Estimated full instrument calibration time 7.0 hours (with LFE 8.0 hours)a
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Items Included in the Upgrade Kit

Table 1 

Check the contents of your kit against the following list. If any part is missing or 
damaged, contact Keysight Technologies. Refer to “Getting Assistance from 
Keysight” on page 5.

Contents of Upgrade Kit N5247-60116 or N5247-60121

Ref 
Desig.

Description Qty  Part Number

Installation note (this document) 1 N5247-90116

Software Entitlement Certificate 1 9300-0000

China RoHS Addendum 1 9320-6722

Assemblies

A9 Noise receiver board 1 N5245-60124

A23 Test set, motherboard PCA 1 N5245-60157

A56 & Bypass switch, port 1 and port 2 2 N1811-60010 

A57

A59 Noise downconverter (receiver – 50 GHz Option 029 – N5247-60116) 1 5087-7344

Noise downconverter (receiver – 67 GHz Option E29 – N5247-60121) 5087-7464

A64 Tuner 1 5087-7345

Hardware/Miscellaneous

Termination (2.44 mm SMA), 50 ohm – 50 GHz 1 0955-2394

Bracket, A56 and A57 noise bypass switches 2 N5245-00033

Machine screw, M3.0 x 8, pan head (to attach A56 and A57 to side frame) 4 0515-0372

Machine screw, M3.0 x 12, pan head (to attach A64 to side frame) 2 0515-0664

Machine screw, M2.5 x 20, pan head (to attach switch brackets to side frame) 4 0515-1992

Machine screw, M3.0 x 14, pan head (to attach A59 to side frame) 3 0515-2994

Lower front panel overlay, N5247A Option 423 with Option 029 1 N5247-80013

Lower front panel overlay, N5247B Option 423 with Option 029 or E29 1 N5247-80023

Lower front panel overlay, N5247B Option 425 with Option 029 or E29 1 N5247-80028

Cables

W162 RF cable, A42 port 1 bias tee to A56 port 1 noise bypass switch 1 N5247-20120

W163 RF cable, A64 tuner to A56 port 1 noise bypass switch 1 N5247-20117

W164 RF cable, A64 tuner to A56 port 1 noise bypass switch 1 N5247-20118
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W165 RF cable, front-panel port 1 CPLR THRU to A56 port 1 noise bypass switch 1 N5247-20119

W166 RF cable, port 2 CPLR THRU to A57 port 2 noise bypass switch 1 N5247-20124

W167 RF cable, A57 port 2 noise bypass switch to A45 port 2 bias tee 1 N5247-20123

W168 RF cable, A59 noise downconverter to A57 port 2 noise bypass switch 1 N5247-20121

W169 RF cable, A59 noise downconverter to A57 port 2 noise bypass switch 1 N5247-20122

W171 RF cable, A59 noise downconverter to A9 noise board 1 N5247-20144

W172 Coaxial cable, A59 noise downconverter assembly J3 to A9 noise board J1 1 N5245-60020

W173 RF cable, A59 noise downconverter to A9 noise board 1 N5247-20145

W174 RF cable, A28 mixer brick to A59 noise downconverter 1 N5247-20143

W175 Coaxial cable, A59 noise downconverter assembly J2 to A9 noise board J5 1 N5245-60019

W189 RF cable, A42 port 1 bias tee to A56 port 1 noise bypass switch 1 N5247-20172

W190 RF cable, A74 Bias Tee combiner, Port 2 to A57 noise switch, port 2 1 N5247-20173

Ribbon cable, A59 noise downconverter J1 port 1 to A23 test set motherboard 
J548

1 N5245-60018

Ribbon cable, A64 tuner J9 to A23 test set motherboard J7 1 N5245-60021

Extra quantities of items such as protective plastic caps, screws, cable ties, 
and cable clamps may be included in this upgrade kit. It is normal for some 
of these items to remain unused after the upgrade is completed.

Table 1 Contents of Upgrade Kit N5247-60116 or N5247-60121

Ref 
Desig.

Description Qty  Part Number
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Installation Procedure for the Upgrade
The network analyzer must be in proper working condition prior to installing 
this option. Any necessary repairs must be made before proceeding with this 
installation.

Overview of the Installation Procedure

“Step 1. Obtain a Keyword and Verify the Information.”

“Step 2. Remove the Outer Cover.”

“Step 3. Remove the Inner Cover.”

“Step 4. Remove the Front Panel Assembly.”

“Step 5.  Remove Some of the Existing Test Set Cables.”

“Step 6. Assemble the A23 Test Set Motherboard.”

“Step 7. Install the A59 Noise Downconverter (Receiver) to the Chassis.”

“Step 8. Install the A57 Noise Switch (Port 2) to Bracket and Attach Cables to 
A59 Noise Downconverter (Receiver) Assembly.”

“Step 9. Install Semirigid Cables to the Noise Assembly.”

“Step 10. Install Switch Bracket and Switch.”

“Step 11. Install the A56 Switch to Bracket and Bracket to the Chassis.”

“Step 12. Install the A64 Tuner to Chassis and Attach Cable to the Tuner.”

“Step 13. Install the A9 Noise Receiver Board.”

“Step 14. Install the New Test Set Cables.”

“Step 15. Replace the lower front panel overlay.”

“Step 16. Reinstall the Front Panel Assembly.”

“Step 17. Install the New Lower Front Panel Overlay.”

“Step 18. Position the Cables and Wires to Prevent Pinching.”

“Step 19. Reinstall the Inner Cover.”

“Step 20. Reinstall the Outer Cover.”

“Step 21. Remove Option 028 License (“A” Model Instruments Only).”

“Step 22. Enable Option 029 or E29.”

This installation requires the removal of the analyzer’s protective 
outer covers. The analyzer must be powered down and 
disconnected from the mains supply before performing this 
procedure.
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“Step 23. Verify the PNA Analyzer Program is Running with the Correct 
Options.”

“Step 24. Perform Post-Upgrade Adjustments and Calibration.”

“Step 25. Prepare the PNA for the User.”

Step 1. Obtain a Keyword and Verify the Information

Follow the instructions on the Software Entitlement Certificate supplied to 
obtain a license key for installation of this upgrade. Refer to “License Key 
Redemption” on page 7.

Verify that the model number, serial number, and option number information 
on the license key match those of the instrument on which this upgrade will be 
installed.

If the model number, serial number, or option number do not match those on 
your license key, you will not be able to install the option. If this is the case, 
contact Keysight for assistance before beginning the installation of this 
upgrade. Refer to “Contacting Keysight” on page 5.

Once the license key file has been received and the information verified, you 
can proceed with the installation at step 2.

Step 2. Remove the Outer Cover

For instructions, click the Chapter 7 bookmark “Removing the Covers” in the 
PDF Service Guide.

Step 3. Remove the Inner Cover

For instructions, click the Chapter 7 bookmark “Removing the Covers” in the 
PDF Service Guide.

If the model number, serial number, or option number do not match those 
on your license key file, you will not be able to install the option. If this is 
the case, contact Keysight for assistance before beginning the installation 
of this upgrade. Refer to “Contacting Keysight” on page 5.

This procedure is best performed with the analyzer resting on its front 
handles in the vertical position. Do not place the analyzer on its front panel 
without the handles. This will damage the front panel assemblies.
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Step 4. Remove the Front Panel Assembly

For instructions, click the Chapter 7 bookmark “Removing and Replacing the 
Front Panel Assembly” in the PDF Service Guide1.

Step 5. Remove Some of the Existing Test Set Cables 

To see an image showing the location of some of the cables click the Chapter 6 
bookmark “Top Cables, All Cables - All Options (S/N Prefixes <6021)” or “Top 
Cables, All Cables - All Options (S/N Prefixes ≥6021)” in the PDF Service 
Guide1. And, to see an image showing the location of the other cables, click the 
Chapter 6 bookmark “Bottom RF Cables, 2-Port, Option 423 (S/N Prefixes 
<6021)”or “Bottom RF Cables, 2-Port, Option 423 (S/N Prefixes ≥6021)”1.

1. Place the analyzer bottom-side up on a flat surface.

2. Remove the following cables in the order listed. Unless otherwise marked, 
discard these cables; they will not be reused.

 
For Option 423 Only:

— N5247-20027 Port 2 CPLR THRU to A45 port 2 bias tee 

— N5247-20080 A45 port 2 bias tee to A36 port 2 coupler

— N5247-20029 A44 port 4 bias tee to A35 port 4 coupler

— N5247-20021 Port 4 CPLR THRU to A44 port 4 bias tee

— N5247-20022 A33 port 1 coupler to A42 port 1 bias tee

— N5247-20010 Port 3 CPLR THRU to A43 port 3 bias tee

— N5247-20081 Front-panel port 1 CPLR THRU to A42 port 1 bias tee

— N5247-20028 A43 port 3 bias tee to A34 port 3 coupler

— N5247-20058 A32 port 2 ref coupler to front-panel REF 2 SOURCE 
OUT

1. See “Downloading the Online PNA Service Guide” on page 8.

Be careful not to damage the center pins of the semirigid cables. Some 
flexing of the cables may be necessary but do not over-bend them.

Leave the gray flexible cables, the wire harnesses, and the ribbon cables 
connected where possible. Any that are removed should be labeled for 
reconnection later. 
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For Option 425 Only:

— N5247-20163 Port 2 CPLR THRU to A74 port 2 bias tee 

— N5247-20167 Front-panel port 1 CPLR THRU to A71 port 1 bias tee

Step 6. Assemble the A23 Test Set Motherboard

For instructions, click the Chapter 7 bookmark “Removing and Replacing the 
A23 Test Set Motherboard” in the PDF Service Guide1.

1. See “Downloading the Online PNA Service Guide” on page 8.
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Step 7. Install the A59 Noise Downconverter (Receiver) to the Chassis

Refer to Figure 2 for this step of the procedure. New parts are listed in Table 1 
on page 11.

1. Attach the new noise downconverter receiver (item ) to the chassis as 
shown.

Secure the noise downconverter receiver to its bracket using three screws, 
but do not torque. The screws will be torqued after the simirigid cables are 
installed. 

Figure 2 Noise Receiver (5087-7344, 5087-7464 and 0515-2994)
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Step 8. Install the A57 Noise Switch (Port 2) to Bracket and Attach 
Cables to A59 Noise Downconverter (Receiver) Assembly

Refer to Figure 3 for this step of the procedure. New parts are listed in Table 1 
on page 7.

1.  Install ribbon cable (Item  - N5245-60018) to J1 on the noise assembly 
as shown in Figure 3. Later the other end plugs into the A23 test set 
motherboard. 

2. Connect coax cable (Item  - N5245-60019) to J2 on the noise assembly 
as shown in Figure 3. Later the other end connects to the noise board. 

3. Connect coax cable (Item  – N5245-60020) to ’J3 IF out’ on the noise 
assembly as shown in Figure 3. Later the other end connects to the noise 
board.

Figure 3 Attach Cables to Noise Receiver Assembly (N5245-60018, N5245-60019, & 
N5245-60020)

A23
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Step 9.    Install Semirigid Cables to the Noise Assembly

Refer to Figure 4 for the following:

1. Torque N5247-20058 to 10 in-lbs and add clamps 1400-1334 (x3, item 
).

2. Torque N5247-20145 to 10 in-lbs. The other end to be connected at “Step 
14. Install the New Test Set Cables” on page 24. Add cable ties 1400-0249 
(x2, item ).

3. Torque N5247-20144 to 10 in-lbs. The other end to be connected at “Step 
14. Install the New Test Set Cables” on page 24. 

4. Torque the 0515-2994 (x3, Item ) screws to the noise assembly and 
chassis to 9 in-lbs.

Figure 4 Install the Semirigid Cables to the Noise Assembly (N5247-20058, 
N5247-20144, N5247-20145, 0515-2994, 1400-0249, 1400-1334)
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Step 10. Install Switch Bracket and Switch

Refer to Figure 5 for this step of the procedure. New parts are listed in Table 1 
on page 7.

1. Install the Switch bracket (item ) to the left side chassis. Secure with 2 
screws and torque to 9 in-lbs.

2. Install the A57 Switch to the switch bracket using two screws (Item ). 
Torque to 9 in-lbs.

3. Plug in switch harness (Item ) to downconverter J41 port 2.

Figure 5 Attach Switch Bracket and Switch (N5245-00033, N1810-60010, 0515-0372, 
& 0515-1992)
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Step 11. Install the A56 Switch to Bracket and Bracket to the Chassis

Refer to Figure 6 for this step of the procedure. New parts are listed in Table 1 
on page 11.

1. Install the bracket (item  – N5245-00033) to the switch bracket using 
two screws.

2. Install switch (Item  – N1811-60010) and to bracket. Secure with two 
1515-0372 screws. Torque to 9 in-lbs. 

3.  Plug in switch harness (Item ) to downconverter J42 port 1.

Figure 6 Install the A56 Noise Switch (Port 1) to Bracket and Attach Cables to A64 
Tuner Assembly (N1811-60010, N5245-00033, 0515-0372 and 0515-1992)

Route the switch harness in between the bias tees.
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Step 12. Install the A64 Tuner to Chassis and Attach Cable to the 
Tuner

Refer to Figure 7 for this step of the procedure. New parts are listed in Table 1 
on page 11.

1. Install the tuner (item  – 5087-7345) to the chassis using two screws. 
Torque to 9 in-lbs.

2. Plug in ribbon cable (Item  - N5245-60021) to J9 on the A64 tuner. The 
other end is connected at final to the test set mother board. 

Figure 7 Install the Tuner to the Chassis and Attach Cable to the A64 Tuner Assembly 
(5087-7345, N5245-60021, & 0515-0664)
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Step 13. Install the A9 Noise Receiver Board

Refer to Figure 8 for this part of this step of the procedure. Although only 
Option 422 is shown in the illustration, Option 423 and Option 425 with 029 or 
E29 are similar in appearance. New parts are listed in Table 1 on page 11.

1. Place the analyzer top-side up on a flat surface.

2. Insert the A9 noise receiver board in the analyzer as shown. Make sure it is 
fully seated in the motherboard connector.

Figure 8 Noise Receiver Board Installation
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Step 14. Install the New Test Set Cables

Refer to Figure 9 on page 27 through Figure 12 on page 30 for this step of the 
procedure. Although only Option 423 is shown in the illustrations, Option 425 
is similar in appearance. To see an image showing the location of these cables, 
click the appropriate Chapter 6 bookmark (e.g., “4-Port Configuration, Options 
423/029/E29 (S/N Prefixes <6021)” or “4-Port Configuration, Options 
423/029/E29 (S/N Prefixes ≥6021)”) in the PDF Service Guide1. New parts are 
listed in Table 1 on page 11.

1. Connect the following wire harness and ribbon cables:

Connect the following, by referring to Figure 10 on page 28:

— —(N5247-20145) A59 noise downconverter to A9 noise board.

— —(N5247-20144) A59 noise downconverter to A9 noise board.

Connect the following by referring to Figure 11 on page 29 (See also 
Figure 7 on page 22.):

— —(N5245-60020) Verify A59 noise downconverter assembly J3 to 
A9 noise board J1 “IF IN”.

— —(N5245-60019) Verify A59 noise downconverter assembly J2 to 
A9 noise board J5 “DET IN”. 

Connect the following by referring to Figure 12 on page 30 (See also 
Figure 3 on page 18 and Figure 7 on page 22.):

— —(N5245-60018) A59 noise receiver to the A23 test set 
motherboard J550.

Follow instructions carefully when making cable connections, especially 
wire harness connections. Incorrect connections can destroy components, 
resulting in additional customer costs.

Be careful not to damage the center pins of the semirigid cables. Some 
flexing of the cables may be necessary but do not over-bend them.

Use a 5/16-in torque wrench set to 10 in-lbs on all cable connections 
except the front and rear panel bulkhead connectors. On these, use a 9 
mm nutsetter or open end torque wrench set to 21 in-lb.

1. See “Downloading the Online PNA Service Guide” on page 8.

The reference designators in this step correspond to the figures Figure 9 on 
page 27 through Figure 12 on page 30. But, some of the previous steps are 
provided for your reference.
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— —(N5245-60021) Verify A64 tuner to A23 test set motherboard J7 

2. Install the following semirigid cables in the order listed. Unless otherwise 
indicated, use a 5/16-in torque wrench set to 10 in-lbs to tighten all cable 
connectors.

All model analyzers, unless otherwise indicated:

— W166 (N5247-20124) Port 2 CPLR THRU to A57 port 2 noise bypass 
switch 

— 425+029 or 425+E29 Only! W190 (N5247-20173) A74 Port 2 bias 
tee combiner to A57 port 2 noise bypass switch 

— W165 (N5247-20119) A42 port 1 bias tee to A56 port 1 noise bypass 
switch

— 425+029 or 425+E29 Only! W189 (N5247-20172) A71 port 1 bias 
tee to A56 port 1 noise bypass switch

— 423+029 or 423+E29 Only! W167 (N5247-20123) A57 port 2 noise 
bypass switch to A45 port 2 bias tee 

— W169 (N5247-20122) A59 noise downconverter to A57 port 2 noise 
bypass switch 

— W168   (N5247-20121) A59 noise downconverter to A57 port 2 
noise bypass switch 

— 423+029 or 423+E29 Only! W162 (N5247-20120) A42 port 1 bias 
tee to A56 port 1 noise bypass switch 

— W164 (N5247-20118) A64 tuner to A56 port 1 noise bypass switch 

— W163 (N5247-20117) RF cable, A26 splitter to A27 mixer brick 

— W174 (N5247-20143) A59 noise downconverter to A28 mixer brick 

3. Position the analyzer as shown in Figure 9 on page 27 through Figure 12 
on page 30 (fans facing upwards) and loosely install the following cables. 
Route each of the cables through the opening in the test set deck to the 
top side of the analyzer. The other ends will be connected in the next step.

— W173 (N5247-20145) A59 noise downconverter to A9 noise board 

— W171 (N5247-20144) A59 noise downconverter to A9 noise board 

— N5245-60018 Flexible cable, A59 noise receiver to the A23 test set 
motherboard J550

— W175 (N5245-60019) Flexible cable, A59 noise downconverter 
assembly J2 to A9 noise board J5

If necessary loosen the noise microcircuit to install cables. Re-torque 
connectors to 10 in-lbs. after the cables have been installed.
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— W172 N5245-60020 Flexible cable, A59 noise downconverter 
assembly J3 to A9 noise board J1

— N5245-60021 Flexible cable, A64 tuner to A23 test set motherboard 
J7

Refer to Figure 9 on page 27 through Figure 12 on page 30 for this part of this 
step of the procedure. Although only Option 423 with 029 or E29 is shown in 
the illustration, Option 425 with 029 or E29 is similar in appearance. New parts 
are listed in Table 1 on page 11.

4. The analyzer should be positioned on its left side (fans facing upwards) as 
shown.

5. Connect semirigid cables W171 (item ) and W173 (item ) as indicated 
in Figure 10 on page 28. Torque connectors to 10 in-lbs.

6. Connect flexible cable W172 (item ) and W175 (item ) as indicated in 
Figure 11 on page 29.

7. Connect flexible cable N5245-60018 (item ) and N5245-60021 (item ) 
as indicated in Figure 12 on page 30.

8. Go back and torque the connectors on the other ends of W171 and W173 
to 10 in-lbs.
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Figure 9 New Test Set Cable Installation, Part 1 (Option 423 with 029 or E29 Shown)
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Figure 10 New Test Set Cables Installation, Part 2 (N5245-20144, N5245-20145)

A9 Noise 
board
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Figure 11 New Test Set Cables Installation, Part 3 (N5245-60019, N5245-60020)
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Figure 12 New Test Set Cable Installation, Connect to A23 (TSMB), Part 4 
(N5245-60018, N5245-60021)
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Step 15. Replace the lower front panel overlay

Refer to Figure 13 for this step of the procedure. New parts are listed in Table 1 
on page 11.

1. From the back side of the front panel, use a blunt object in the cutouts in 
the lower front dress panel to push on the old overlay (item ) and 
separate it from the front dress panel.

2. From the front side of the front panel, pull off the overlay completely and 
discard it.

3. Remove any adhesive remaining on the front panel.

Figure 13 Lower Front Panel Overlay Replacement

IMPORTANT! To avoid possible damage to the lower front panel overlay, 
do not attempt to attach the lower front panel label until “Step 17. Install 
the New Lower Front Panel Overlay” on page 33.
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Step 16. Reinstall the Front Panel Assembly

Refer to Figure 14 for this step of the procedure. New parts are listed in Table 1 
on page 11.

1. Reconnect the ribbon cable (item ) to the A1 front panel interface board.

2. Slide the front panel over the front-panel connectors.

3. With a T-10 TORX driver, reinstall the 12 screws (item ) in the sides of 
the frame.

Figure 14 Front Panel Assembly Re-installation

Before installing the front panel assembly onto the analyzer, lift and 
support the front of the analyzer chassis. 
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Step 17. Install the New Lower Front Panel Overlay 

Refer to Figure 13 on page 31 for the lower overlay and to Figure 14 on 
page 32 for the hex nuts installation for this step of the procedure. New parts 
are listed in Table 1 on page 11.

1. Remove the protective backing from the new front panel overlay, 
N5247-80013 (N5247A Option 423 with 029 or E29), N5247-80023 
(N5247B Option 423 with 029 or E29), or N5247-80028 (N5247B Option 
425 with 029 or E29) — (item ).

2. Starting from either side, loosely place the overlay in the recess on the 
lower front panel, ensuring that it fits tightly against the edges of the 
recess.

3. Once the overlay is in place, press it firmly onto the frame to secure it.

4. Reinstall all of the semirigid jumpers (item ) on the front-panel, and 
tighten each of the connectors using a 5/16-in torque wrench set to 
10 in-lbs. Refer to Figure 14 on page 32.

Step 18. Position the Cables and Wires to Prevent Pinching

On the top side of the PNA, carefully position the grey flex cables so they can’t 
be pinched between the covers and the rails.

On the bottom side of the PNA, carefully fold or push down the ribbon cables 
and wires so they can’t be pinched between the hardware and the outer cover. 
Ribbon cables and wires must never be positioned on top of hardware.
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Step 19. Reinstall the Inner Cover

Refer to Figure 15 for this step of the procedure.

1. Position the inner cover on the analyzer.

2. With a T-10 TORX driver, install the 12 pan head screws (item ).

3. With a T-10 TORX driver, install the 9 flat head screws (item ).

Figure 15 Inner Cover Re-installation
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Step 20. Reinstall the Outer Cover 

Refer to Figure 16 for this step of the procedure.

1. Slide the outer cover over the analyzer frame.

2.  Install the four rear panel feet (item ) by installing the center screws 
(item ) with a T-20 TORX driver.

3. Install the four bottom feet (item ) onto the bottom of the outer cover 
then install the foot locks (item ).

4. Install the strap handles (item ) by tightening the screws (item ) on 
both ends of each strap handle with a T-20 TORX driver.

Figure 16 Outer Cover Re-installation

This procedure is best performed with the analyzer resting on its front 
handles in the vertical position. Do not place the analyzer on its front panel 
without the handles. This will damage the front panel assemblies.



 36                                                                                                                               Installation Note N5247-90116

Description of the Upgrade
Installation Procedure for the Upgrade

-

Step 21. Remove Option 028 License (“A” Model Instruments Only)

Procedure Requirements

— The analyzer must be powered up and operating to perform this procedure.

— The Network Analyzer program must not be running.

— A keyboard and mouse must be connected to the network analyzer.

Option 028 License Removal Procedure

1. To start the option enable utility, press UTILITY , then , 

then  . An option enable dialog box will appear.

2. Click the arrow in the Select Desired Option box. A list of available options 
will appear.

3. Click the on the desired option 028 and click red Remove button.

4. A message displays stating that the option removal was successful.

5. Exit the Option Enable window.

6. Restart the PNA Analyzer application: Press File > Exit.

7. In the Exit NA Application dialog box that opens, press OK.

If Option 028 is not loaded on your PNA, proceed to “Step 22. Enable 
Option 029 or E29” on page 37. 

System Service

Option Enable
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Step 22. Enable Option 029 or E29

Procedure Requirements

— The analyzer must be powered up and operating to perform this procedure.

— The Network Analyzer program must not be running.

— Refer to the license message you received from Keysight: Verify that the 
analyzer’s model and serial numbers match those on the license message 
you received from Keysight.

— A keyboard must be connected to the network analyzer.

For “A” models, refer to:

—  “Option Enable Procedure for “A” Model Instruments” on page 38.

—  ““A” Model Option Verification Procedure” on page 38.

For “B” models refer to:

—  “Option Enable Procedure for “B” Model Instruments” on page 38.

—  ““B” Model Option Verification Procedure” on page 39.

For this step, you will need a USB flash drive.

A single license file may contain more than one feature.
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Option Enable Procedure for “A” Model Instruments

1. To start the option enable utility, press UTILITY , then , 

then  . An option enable dialog box will appear.

2. Click the arrow in the Select Desired Option box. A list of available options 
will appear.

3. In the Select Desired Option list, click 029 - Noise Figure Measurements.

4. Using the keyboard, enter the license key in the box provided. The license 
key is printed on the license message you received from Keysight. Enter 
this key exactly as it is printed on the message.

5. Click Enable.

6. Click Yes in answer to the displayed question in the Restart Analyzer? box.

7. When the installation is complete, click Exit.

“A” Model Option Verification Procedure

Once the analyzer has restarted and the Network Analyzer program is again 
running:

1. On the analyzer’s Help menu, click About Network Analyzer.

2. Verify that “029” is listed after “Options:” in the display. Click OK.

Option Enable Procedure for “B” Model Instruments

1. Locate the email(s) from Keysight which contain license file attachments. 
These emails are a result of Step 3 on “License Key Redemption” on 
page 7.

2. Copy the license file(s) from the email(s) to the root directory of the USB 
flash drive.  
More than one license file may be copied to the USB flash drive. 

3. Insert the USB flash drive to the PNA’s USB drive slot. Within 5 seconds, 
the PNA should display a small “New licenses installed” message.

System Service

Option Enable

For this step, you will need a USB flash drive.

A single license file may contain more than one feature.

A license file may contain more than one feature.

http://www.keysight.com/find/fieldfoxsupport
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Else, load the license key file(s), manually move your license file(s) to 
C:\Program Files\Agilent\licensing. It may take Keysight License 
Manager an extra ~5 seconds to enable the licenses.

4. Disconnect the USB flash drive from the PNA.

5. On the analyzer, click or press to open the KLM software from your PNA’s 
Windows taskbar by pressing Start > More Programs > Keysight License 
Manager folder > Keysight License Manager and verify the options are 
correct. 

“B” Model Option Verification Procedure

Once the Network Analyzer program is again running:

1. Start the Network Analyzer program.

2. Once the Network Analyzer program is running: 

— Press Help > About NA and verify that Option 029 or E29 is listed in 
the PNA application. 

3. After successful installation of all upgrades, some features require some 
adjustments to ensure the instrument meets its specified performance. 
Refer to the Adjustments (i.e., Diagnostic Tools, Utilities, and 
Adjustments) topic in the PNA Online Help: 
https://rfmw.em.keysight.com/wireless/helpfiles/N52xxB/help.htm.

Attempting to re-install a license file that is already installed may generate 
a “Corrupt Media” error message. Ignore this message.

If the option has not been enabled, contact Keysight Technologies. Refer 
to “Getting Assistance from Keysight” on page 5.

https://rfmw.em.keysight.com/wireless/helpfiles/N52xxB/help.htm
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Step 23. Verify the PNA Analyzer Program is Running with the Correct 
Options

Once the Network Analyzer program is again running:

1. Start the Network Analyzer program.

2. Once the Network Analyzer program is running: 

— Press Help > About NA and verify that Option 029 or E29 is listed in 
the PNA application. 

3. After successful installation of all upgrades, some features require some 
adjustments to ensure the instrument meets its specified performance. 
Refer to the Adjustments (i.e., Diagnostic Tools, Utilities, and 
Adjustments) topic in the PNA Online Help: 
https://rfmw.em.keysight.com/wireless/helpfiles/N52xxB/help.htm.

Step 24. Perform Post-Upgrade Adjustments and Calibration

Adjustments

The following adjustments must be made due to the hardware changes of the 
analyzer.

— Default EE adjustment - select the LO Drive-NF adjustment and either 
adjust or initialize the values.

— Source Adjustment

— IF Gain Adjustment

— Receiver Characterization

— Receiver Adjustment

— IF Response Adjustment (N5247A with Option 090, 093, 094, or N5247B 
with Option S93090xA/B, S93093A/B, or S93094A/B Only)

— Noise Figure Adjustment (Option N5247A 029 or N5247B 029 or E29 with 
S93029A/B Only)

These adjustments are described in the PNA Service Guide and in the PNA 
on-line HELP. A list of equipment required to perform these adjustments is also 
found in the service guide.

To view this service guide information, click the Chapter 3 bookmark “Tests 
and Adjustments” in the PDF Service Guide1. 

If if the option(s) have not been enabled or if your older options have not 
been removed, contact Keysight Technologies. Refer to “Getting 
Assistance from Keysight” on page 5.

1. See “Downloading the Online PNA Service Guide” on page 8.

https://rfmw.em.keysight.com/wireless/helpfiles/N52xxB/help.htm
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After the specified adjustments have been performed, the analyzer should 
operate and phase lock over its entire frequency range. 

Operator’s Check

Perform the Operator’s Check to check the basic functionality of the analyzer. 
For instructions, click the Chapter 3 bookmark “Tests and Adjustments” in the 
PDF Service Guide1.

If you experience difficulty with the basic functioning of the analyzer, contact 
Keysight. Refer to “Contacting Keysight” on page 5.

Calibration

Although the analyzer functions, its performance relative to its specifications 
has not been verified. It is recommended that a full instrument calibration be 
performed using the analyzer’s internal performance test software. To view 
information on the performance test software, click the Chapter 3 bookmark 
“Tests and Adjustments” in the PDF Service Guide1.

EEPROM Backup

The analyzer uses arrays of correction constants to enable the analyzer to 
produce accurate, leveled source signals and receive clean test signals. These 
constants are stored in non-volatile EEPROM memory and in flash memory 
files.

The adjustments listed here generate new correction constants. The analyzer 
must have a backup of this new data in case any of the data becomes 
corrupted.

To store the backup data, perform these steps:

— Navigate to the EEPROM Backup Utility, located at: 

— Windows 7 -- C:\Program Files (x86)\Keysight\Network 
Analyzer\Service\eebackup.exe

— Windows 10 -- C:\Program Files\Keysight\Network 
Analyzer\Service\eebackup.exe

— Run the program.

— Click Backup EEPROM.

— Click Backup TSMB Mem.

— Click Backup Synth Mem. (Applies to Version 7 Synthesizers Only)

— Click Exit when the program has finished.

1. See “Downloading the Online PNA Service Guide” on page 8.
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Figure 17 EEPROM Backup Menu

Step 25. Prepare the PNA for the User

1. If necessary, reinstall front jumper cables.

2. Install the cable guards, pushing them over the front jumper cables until 
the cushioning material touches the front panel of the PNA.

3. Install the dust caps on the test ports.

4. Clean the analyzer, as needed, using a damp cloth.
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